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Praktikum Digitaltechnik SS 2011
Versuch 3

Stand: 16. 6. 11

Versuchsplattform:

Lehrgerat 10a mit CPLD Evaluation Board (Pollin) und zwei Siebensegmentanzeigen 10a. Eingebaute
Ein- und Ausgabemittel: vier Taster, acht LEDs, serielle Schnittstelle. Entwicklungssoftware: Xilinx
ISE 9.x.

Aufgaben:

Den Entwicklungsgang kennenlernen.

Passende Taktfrequenzen herstellen.

Lauflicht.

Zwei Bindrzahler mit Handbetatigung und Anzeige.
Stoppuhr.

Prufgenerator fur serielle Schnittstellen.

Aufgabe 1: Den Entwicklungsgang kennenlernen
Das erste Projekt betrifft ein RS-Flipflop und ein Toggle-Flipflop, die mit Tasten und Leuchtdioden
zu verbinden sind.

1. Software starten.

VT EH SR

| @Erors | g, Wamings | @TaiShell | igs Findin Fles

proje
J Start [

Abb. 1 Anlegen eines neuen Projekts. Funktionsaufruf.
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2. Projekt benennen.

=y
L Xilinx - ISE

Fle Edt View Froject Source Process Window Help
DRPEHA LR EX D QILPLHRR
Ix]

AiBBE DDA K @@ WU

I

No project is open

Select
File->Open Project

ar
File-»Mew Project

3 Source gy Snapsh| [y Librarit
{x]
No flow available. ES New Project Wizard - Create New Project

Enter a Name and Location for the Project
Froject Name:
“uebung_01 | Higitaltechnikixili

Select the Type of Top-Level Source for the Project

Top-Level Source Type:

Abb. 2 Das neue Projekt erhalt einen Namen. 1 - Namenseingabe. 2 - das
Projekt soll als Schaltplan erfal3t werden.

3. Schaltkreis auswahlen.

E New Project Wizard - Device Properties

Selectthe Device and Design Flow for the Project
Property Name. Lele

Product Category (Al

Family | XC9500XL CPLDs
Device |E
Package |TQ100
Speed I8

Top-Level Source Type [Schematic

Synthesis Tool | XST (VHDL/Verilog)
Simulator ISE Simulatar (VHDL/Verilog)
Prefered Language Verilog

Enable Enhanced Design Summary []
Enable Message Fittering
Display Incremental Messages [

[<oes J(Ne> ] [conel ]

Abb. 3 Schaltkreisauswahl. 1 - es ist die Baureihe 9500XL. 2 - es ist der Typ
95144. 3 - der Schaltkreis befindet sich in einem Flatpack-Geh&use mit 100
Anschlissen.
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4. Die erste Quelldatei einrichten.

E New Project Wizard - Create New Source

Create a New Source
Source File Type |
1 | Femaove

Creating a new source to add to the projectis optional. Only one new source can be created with
the New Project Wizard. Additional sources can be created and added to the project by using
the "Project->New Source" command.

Existing sources can be added on the next page.

<Back |[ Next> | [ Cancel |

Abb. 4 Einrichten der ersten Quelldatei.

E New Project Wizard - Create New Source

EE New Source Wizard - Select Source Type

[2] Schematic

2 State Diagram
[#] TestBench WaveForm 2
[E)User Document

[¥)verilog Module File name:

[V] Verilog Test Fixture
[ VHDL Module 3
[ VHDL Library Location:

’uebung_m |

[F] VHDL Package |[LAafbdigitatechnikiXilinxversuche_11\we, [__]
[%) VHDL Test Bench

Add to project

<Back [ Next > ][ Cancel ]
|M:|ralnfo I <Back ][ Next> | I Cancel ]

Abb. 5 Es soll ein Schaltplan sein. 1 - den Typ der Quelldatei wahlen. 2 -
Namen eingeben (beliebig; Dateiendung wird automatisch nachgesetzt).
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_E New Project Wizard - Create New Source

E New Source Wizard - Summary

| Project Navigator will create a new skeleton source with the following specifications:

| Add to Project: Yes

| Source Directory: LAafb3digitaltechnikiXilinxversuche_11\uebung_01
Source Type: Schematic

Source Name: uebung_01 sch

[ <Back || Finish

|
|Mar&lnfn | <Back || Next> |

£ New Source Wizard - Summary

[ Project Navigator will create a new skeleton source with the following specifications:

Add to Proje
Source Dire
Source Type;
Source Mame| .
|_\?) The directory
‘L Aafb3\digitaltechnikilineversuche_ 1 1uebung_01'

does not exist. Would you like to create it?

Lyes J[ Mo |

[ <Back || Finish | [ cancel |

|M0relnicl| | <Back || Next> | | Cancel |

E New Project Wizard - Create New Source

Create a New Source

MNew Source...

Source File Type
1 uebung_01.sch Schematic

Creating & new source to add to the project is opfional. Only one new source can be created with
the New Project Wizard. Additional sources can be created and added to the project by using
the "Project->Mew Source" command.

Existing sources can be added on the next page.

<Back |[ Next> | [ Cancel

Abb. 6 Alle diese Dialoge sind zu durchlaufen, um die Quelldatei tatséchlich zu
erzeugen.
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ES New Project Wizard - Add Existing Sources

Add Existing Sources

Source File Copy to Prajm:

Remaove

]

Adding existing sources is optional. Additional sources can be added Mter the project is created
using the "Project->Add Source” or "Project->Add Copy of Source” com ds.

[ < Back ” Mext > I | Cancel ]

Abb. 7 Hier wird die Gelegenheit geboten, weitere Quelldateien hinzuzufiigen.
Brauchen wir aber nicht. Also gleich weiter...

E New Project Wizard - Project Summary

Project Name: uebung 01
Project Path: L:\afb3\digitaltechnik\Xilinxversuche
Top Level Source Type: Schematic

Device:
Device Family: XC9500XL CPLDs
Device: xc95144x1
Package: TQ1l00
Speed: -5

Synthesis Tool: XST (VHDL/Verilog)

v
Saimunlakmam:s TOD Cimulakaw [TURT Mlamd 1ot |

| A
o

[ <Back || Finish | | Cancel |

Abb. 8 Das ist der abschlieRende Uberblick tiber das neue Projekt.
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5. Schaltplan eingeben.

S xilinx - 1SE - L:\afb3digitaliechn aversuche_11luebung 01\uebung 01, ise - [uebung_01.sch]
) Fle Bt View Project Source Process Took Window Hep
DAEG L XBRX 90 AAPXXAE A RE

i

=3 Sour | gy Snaps| [y Lbra| D Symt
]
s

Select Opboss
Wheyou chek o 8 branch
() Select #oe antre beanch
) Selact Ba Ine segmert

Wt you MovE o object
() Knop e consecton o
othar cbfecs

) Break foe connecsons 1
cher objech

‘Whan you use e srea select
100l select e chiacts fat
(8) Are enciosed by the anes
) Insensctihe asma

< »

g Processes | 22 Optons |

wbung_11.9ch

[5] Process "Creating Schematic” completed successfully

started : "Launching Schematic Editor to edit uebung_Dl.sch".

¢
[ Console | @ Enon | g Womings | G TSl | [ Fied in Files

5 SWUAALXA "k e LS (23 WO/ 0ADBA T AL

d Symbl

= 2 f

Compasmiar
= 1

@
H
3

started : "Launching Schematic Editor to edit uebung_0l.sch”.

€
i Console | @Enors | g Wamings | @I TSkl | g Find in Files

B suchergsrme 1f, Adobe Photeatop

Abb. 10 Funktionselemente auswahlen. 1 - Auswahlfunktion. Am linken Rand
erscheint ein Katalog der verfiigharen Funktionselemente. 2 - Auswahl der
Kategorie. 3 - hier wird das jeweilige Funktionselement aufgerufen.
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B2 Xilinx - ISE - L:\afb3\digitaltechnik\Xilinxversuche_11\uebung_01\uebung_01.ise

[ Fle Edt View Project Source Process Add Tools Window Help
DAEG LiiDEX D@ NippX® Al Mm@
[x] =

Categories
Butfer e |
Comparator |
Counter
Decoder
Flip_Flop g 1
General

10

Latch

Logic

I
| Shifter
| Shift_Reagister
TTL Ll
Symbols
Tdre
fdrs
fdrse
fds
fdse
fdsr |
T <—— 2
lfike ‘
fikece
(fikep
Hfikcpe

fikp

fikpe v

Symbol Name Filter

Orientation i
Rotate 0 v /
Symbol Info 7

@3 Sou| g Snar [y Libr 2 Sy || @) yebung_01.sch

3

Abb. 11 Das erste Funktionselement soll ein RS-Flipflop sein. 1 - nachsehen,
ob unter den Flipflops etwas Passendes zu finden ist. 2 - wir nehmen ein D-
Flipflop mit zusatzlichen Setz- und Riicksetzeingéngen. Vielleicht tut es der Typ
fdrs? 3 - hieriber kann man genauer nachsehen.

FDRS

D Flip-Flop with Synchronous Reset and Set
Architectures Supported

FDRS
Spartan-11, Spartan-lIE Primitive
Spartan-3 Primitive
Virtex, Virtex-E Primitive

Virtex-11, Virtex-II Pro, Virtex-11 Pro X | Primitive

XC9500, XC9500XV, XCH500XL Primitive
CoolRunner XPLA3 Primitive
CoolRunner-Ii Primitive

Abb. 12 Die Symbol Info ist im Grunde ein Datenblatt. Offensichtlich ist dieses
Flipflop ungeeignet, da die Setz- und Riicksetzeingéange synchron wirken.

Bei Xilinx sind Set (S) und Reset (R) synchron wirkende Eingénge. Die entsprechenden asynchron
wirkenden Eingange heillen Preset (P; PRE) und Clear (C; CLR). Also nehmen wir besser ein Flipflop
fdcp.
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Abb. 13 Das gewiinschte Flipflop auf der Zeichenflache.

Die Taster der Versuchsplattform wirken invertiert, die Flipflopeingénge jedoch nicht (anders als bei den
Flipflopschaltkreisen der ersten beiden Versuche). Wir miissen also Negatoren vorschalten.

Categories
<Al Symbaols—> ~
Agithmetic
Buffer
Comparator
Counter
Decoder
Flip_Flop
General

[a]

Latch

Shifter =

Symbols

T
andsb3
andsbd
andsbs
andf
and?
andd
andd

im6

imd

Logic - ‘I
Mux "

FDCP

|as

SR

T - D

Abb. 14 So wird ein Negator eingebaut. 1 - er ist in der Kategorie Logic zu
finden. 2 - er heil3t hier inv (Inverter). 3- das ausgewahlte Funktionselement. 4 -
die Anschliisse kénnen direkt miteinander verbunden werden (Andocken).

Nun ist die Schaltung mit den Schaltkreisanschliissen zu verbinden. Jeder Anschlul® erfordert zwei
Funktionselemente, einen Buffer und einen Marker. Ein Eingang braucht einen Input Buffer und einen

Input Marker, ein Ausgang einen Output Buffer und einen Output Marker.
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Fiip_Fiop
General : : . - . . - - . . . .
. =1 4 . FDCP
Logic . & | Y . S

:&er b | |BUF ;o PAE _

"‘_2 e D Q—“

Symibols

ibufl6
ibutd
L]
obule | |
o 3

obullG . . o o .
obetd =—>C

ohude . . . . CLR

et ) ) . )
ond - : - . . . . | -
oluded - -

INY

Symibaol Mame Filer

Abb. 15 Puffer einbauen. 1 - diese Funktionselemente finden wir in der
Kategorie 0. 2 - der Input Buffer heil3t ibuf. 3 - der Output Buffer heif3t obuf. 4 -
ein ausgewabhlter Input Buffer.

E Xilinx = ISE = L:\afb3\digitaltechnik\Xilinxversuche_11\ueb2x\ueb2x. ise - [ueb2x sch*]

[ Fle Edt View Project Source Process Add Took Window Help

O3HG L-ADEX wa Q- AAXME R ARENT AR MR SEQEMWE GURAAL -k WP H(x=[R-2 N0
(%]

Categornes

| =2l Symbals=»
Symbols

ibud

Symibol Name Filer ¥ b aactd e . Aot + ¥ 1
COrientation

Rotate 0 >
[ Symbol iy |
g Sources g Snapshot [Py Librarier 2 Symbol: : dadinann Rees 3 :

= it HEa
Addd O Merkar Optors A (|mnnnnnnan R

‘When you click near the end of a
branch, what do you want to do

) Add an sutomstic marker
) Add an output marker ) g Hitity 9! 08 ot I>‘ i
(0 Add a bidirecsonal marker : i ! i L 1

() Remova the marker

Abb. 16 Jetzt werden die Marker nachgesetzt. 1 - Funktionsauswahl. 2 -
Auswahl der Art des Markers. 3 - ein Input Marker, der bereits angedockt wurde.

Die Signalbezeichner mit XLXN sind eine Eigenart des Entwicklungssystems. Sie werden automatisch
vergeben. Auf Dauer kommt man damit nicht zurecht. Wir sollten schon Bezeichner haben, die man sich
merken kann. Hierzu miissen wir die Signale umbenennen.

Rename Port

Object Properties  Alt+Enter .

Abb. 17 Den Signalbezeichner in einem Marker &ndern. 1 - Marker auswabhlen.
Dann rechte Maustaste. 2 - wir benétigen die Funktion Rename Port.
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(®) Rename the Branch's Net
() Rename the Branch
pout 4

Di
It

the N

lame on the Clicked Point(lf
d on the Branch)

[ oK ” Cancel ” Help

Abb. 18 Die Umbenennung. 1 - hier wird der neue Name eingegeben.

Die Schaltung hat noch offene Eingénge. Die darf es aber nicht geben. Also sind sie mit Festwerten zu
beschalten.

Flw_Flop

Genersl - 1 .
0

: = - FDCP

Logie : : - LSET. L= P ] :

ls.iu- IBUF “TINY e

— . . . . . . . . . . . oo . al s - “\} - (D_oUT>
constant OBUF

[RESET

Symbal Name Filer

Oigrasticn
Fuotate O

Abb. 19 Beschalten mit Festwerten. 1 die Festwerte finden wir in der Kategorie
General. 2 - gnd = Low, vcc = High. 3 - ein ausgewahlter Festwert Low.

Die Low-Festwerte (gnd) lassen sich direkt andocken, die High-Festwerte (vcc) nicht. Wenn das
Andocken nicht klappt oder zu unschdn aussieht, sind Drahtverbindungen zu ziehen. Zumeist genligt es,
nur die AnschluBpunkte auszuwéhlen. Das System kann die Leitungen automatisch verlegen
(Autorouting). Wenn es nicht um Schonheit geht, ist das in vielen Féllen ausreichend.
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Abb. 20 Einen Draht ziehen. 1 - Funktionsauswahl. 2 - den ersten Anschluf3
anklicken. 3 - Verbindung zum nachsten Anschluf3 ziehen und dort klicken. Dal3
ein Anschluf3 richtig ausgewahlt wurde, ist an den typischen vier kleinen
Quadraten zu erkennen.

Die erste Teilschaltung ist fertig. Sie ist aber noch mit einem Toggle-Flipflop zu erganzen.

| [RESET>

Abb. 21 Die fertig eingegebene Schaltung. 1 - in der Kategorie Flip-Flop finden
wir ein passendes Toggle-Flipflop ftc. 2 - der Ldscheingang muf3 inaktiv
gehaltenwerden (Low), der Toggle-Eingang aktiv (High). Das Taktsignal kommt
von der Taste. Deshalb ist es zu invertieren.

Jetzt kann die Schaltung implementiert werden.
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a)

Add Took Window Help
PEAZEOE SN 0K v

Categories -
A El Fie Edt View Project Source
Buter 1| SET =
Symbals 20f b DA LiE 50 xS
BUF
consant I |
Sources | SyrhusisAmplomentst v
Symibal Name Filter | Fuebung_0 o o
- circs = ([0 %c95144d-5TON00 2
Orientation broor : : : : ' . : : : (€)%, webung_01 (uebung 01|,
Fiatate 0 ~ —
X
g S g S y Libre 2 Symil [ .
nap) By Lbre g . [RESET >
BE | BUF
Select O) S . . . . . . . . . . . R |k
] . 3 Sour g Snap| By Libee, > Sym |
Whanyoucickenabwch I 2 E—
@® Selectthe erdrabranch || L =

2 Select Oppons
() Setectthe ling segmant

‘When you mave an object
(®) Ksep the connections
1o caher objects

) Brask e connecions
1o other abjects

When you use te area & Do you want to save the changes you made to ‘usbung_01.sch'?
selec ool select he 1

obgects thal i
@ Are enclosed by the : e Mo [ cancd |
area

) intarsect the aree -
< A1 ||z
S Processes | 39 Options

[ webung_01 sch*
Process "Creating Schematic® completed successfully

started : "Launching Schematic Editor to edit uebung_01.sch”. 3

<

Abb. 22 Implementierung einer eingegebenen Schaltung. 1 - die Funktion heil3t Implement Top
Module. Sie ist im Process-Meni zu finden. Im Betriebszustand a) kann man sie aber nicht
aufrufen. 2 - deshalb mussen wir den Source-Dialog in den Vordergrund bringen (b). 3 -
Einzelheiten des Implementierungsablaufs werden im Konsolfenster angezeigt. 4 - der Source-
Dialog. 5 - jetzt 4Rt sich die Implementierung auslosen. c¢) diese Aufforderung sollte bestétigt
werden...

BB xilinx - 15 - Livafb3\digitaltechnik\Xilinxversuche_11\uebung_01\uebung 01, ise - [Lafbi\digitaltechnikiXilinxversuche_1 1\uebung_01\uebung_01_himffit\appletref. him]
B Fle Edt Veew Project Source Frocess Window Help
OAHD L - SN D0 PP HEAN B AN BB -,V R

Sourcen Synthasikimphiraita &
PR B T
051444 5TO100 = e .
et 51 b _
Report
Summary
Design Name uebung_01
Fitting Status Successful
* ¥ . 3 Software Version J.33
X3 Sou g Sno i Lbr| 2 Syn Device Used XC95144XL-5-TQ100
.., Date 5-20-2011, 9:15AM
O AddExiing Souce
o Crenta Hew Source RESOURCES SUMMARY
# 3§ Design Uiles
# 3 UserConsaints Macrocells Used Prerms Used Registers Used Pins Used Function Block Inputs Used
e | 21144 (2%) 1/720 (1%) 2144 (2%) 4181 (%) 1/432 (1%)
[vHoL -]
PIN RESOURCES
Signal Type Required Mapped Pin Type Used Total
Taput 1 1 1o 3 7
Cutput 2 2 GCRAO 1 3
Bidirectional ] 0 GTSI0 0 4
GCK 1 1 GSRI10 o 1
GTS 0 ]
GSR 0 ]
GLOBAL RESOURCES.
B s
O Focabeek [ usbmng 0 sch | Lisidigastachnikyilmessrsuche_11\abung_GTssbung 01_fimdstappistret him

Bl Copyright {c) 1995-2007 Xilinx, Inc. All rights reserved.

Process "Generate Programming File" completed successfully -‘— 1

<
Al Comcle | @ Erors | f, Woeings | [ TciShell | (4 Find in Files

Fertiy

iJ Start B e - 2 - L B suchergebrese 17 Adobe Protcancp | F)EEHSp-Mozla,. || - Adobe Faader 3 — [

Abb. 23 So muf3 es am Ende aussehen. 1 - die entscheidende Erfolgsaussage. 2 - Es wurden
zwei Makrozellen verbraucht. Wir haben zwei Flipflops eingesetzt. Deshalb ist es 0.k. 3 - hier
kénnen detailliertere Berichte angefordert werden, darunter die Booleschen Gleichungen und
die Anschluf3belegungen.
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Das Entwicklungssystem belegt die Schaltkreisanschlusse automatisch. Auf der Versuchsplattform sind
aber die Tasten, LEDs usw. auf bestimmte Anschlisse gefiihrt. Damit alles zusammenpalt, braucht man
eine weitere Quelldatei, das sog. Constraints File. Zun&chst missen wir aber noch einige weitere
Einstellungen vornehmen. Sie dienen dazu, die Versuchschaltung betriebssicher zu machen.

= Xilinx - ISE - L:\afb3\digitaltechnik\Xilinxve|
[@) Fle Edit View Project Source Process Window F
FNDPHS L:idDBX @ P,
| N | |

Sources Synthesis/implementa v 8
= uebung_01 HUNX

= 3 xc95144x-5TQ100

@uuetung o1 oo, | |GG
itter Report

< >
|3 Sou |gg Snap [Py Libr| 2 Synr
(|
Processes for: uebung_01
Add Existing Source
Create New Source
Design Utilities

User Constraints

24 Run e
Rerun
iy

1 2¢ Rerun Al
‘,—3{ Stop

Qpen Without Updating

¥¥aono

B8 &

il Properties...

Abb. 24 Die Dialoge Sources und Processes sind in den Vordergrund zu holen.
1 - mit der rechten Maustaste auf Implement Design klicken. 2 - auf Properties

klicken.
2 Process Properties IZI
Category
Synthesis
Reports
Simulation Model - o I
Programming  Property Name Value |
|Allow Unmatched LOC Constraints |:1 _
| Implementation Template I_O_ptimize Elala_\j
|Use Location Canstraints 2 | Alway's v/
| Output Slew Rate - Fast ¥ = |
P T S W ST Y — S S N r—— = L
Propery display level: | Standerd | Defaul
[ ok || cencel |[ appy |[ Help |

Abb. 25 Verringerung der Flankensteilheit (um das Ubersprechen (Crosstalk)

gering zu halten). 1 - Vorauswabhl, 2 - Flankensteilheit (Slew Rate). Auf Slow
stellen.
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Categary
Synthesis
Fitting
Repors
Simulation Model Praperty N T =
4 operty Name ug
Programming | Use Llobal Uutput Enables 1
|Use Global SeyReset
Create Frogrammable GND Fins on Unused [0 ] _
Macrocell Power Setting [5d v/
| Marm Sentch Path (i
Property display level, | Stenderd | [ Defaul
| ok || cencet |[ apply |[ Hew |

Abb. 26 Was tun mit den ungenutzten Schaltkreisanschliissen? — Verbinden
wir sie vorsichtshalber mit Masse (Programmable GND Pins on Unused I/O).

Nun kdnnen wir die Anschliisse zuweisen. Dazu brauchen wir die neue Quelldatei (Constraints File).

E Xilinx - ISE - L:\afb3\digitaltechnik\Xilinxv
@ Fle Edt View [Sgsi=ed Source Process Window

PELEERD 5
[N dd Source... B
Sources Synthesis Add

Copy of Source...

=] uebung_01 e
Cleanup P
& (1xc95144%-57 g Project Fes

B8 uebun Toggle Paths .
Archive...
Take Snapshot...

Make Snapshot Current

Apply Project Properties...
Source Control »

Abb. 27 Auswahl des Quelldateiassistenten iber Project — New Source.

= New Source Wizard - Select Source Type

[¢] Schematic

% State Diagram 1

[#] Test Bench WaveFom /

B Implementation Constraints File 2
(8] User Document File name:

[¥] Verilog Madule

@Varilng Test Fidure _uahu?g_ﬂ'i

53 VHOL Module b S
hVHDL Librany LhafbSdigitalechnikixilineersuche_11e) [D
[F]VHDL Package

[ VHOL Test Bench

Add to praject

Abb. 28 Die Datei wird erzeugt. 1 - wir brauchen eine Constraints-Datei. 2 -
Eingabe des Dateinamens (beliebig; die Dateiendung wird automatisch
gebildet).

Hinweis: Eine Ubersicht (iber alle hier genutzten Anschliisse befindet sich am Ende dieser
Versuchsanleitung.
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E New Source Wizard - Summary

Project Navigator will create a new skeleton source with the following specifications:

| Add to Project Yes

| Source Directory: L\afb3\digitaltechnikyi

| Source Type: Implementation Constraints File
Source Name: uebung_01.uct

he_11%uebung_01

| Association: uebung_01

[ < Back “ Fimish | l Cancel

Abb. 29 AnschlieRend ist dieser Dialog zu durchlaufen.

= Xilinx - ISE - L:\afb3\digitaltechnik\Xilinxv
[9) File Edit View Project Source Process Window |

‘DA EHD L:DRX D Q:9
I

P P T |
Sourceg Synthesis/implementa v z
uebung_01 XII"INX

“Fitter Report

=R ¥ xc95144x-5TQ100

= [0)eh uebung_01 (uebung_|
/ ) uebung_01.ucf (uebu

1

2

< >
&3 Sou g Snapé D Libr| > Syn.

Abb. 30 Die neue Datei erscheintim Quellenverzeichnis. 1 - hier klicken; 2 - die
neue Datei.

Wenn wir auf die Datei doppelklicken, sollte sie gedffnet werden, und zwar mit einem passenden Editor.
Wir arbeiten hier mit dem sog. Floorplan Editor. Wird statt dessen ein anderes Programm gestartet, sind
die Einstellungen zu andern. Wird nichts gestartet, ist der Floorplaneditor im Programmstartmeni
(Windows) zu aktivieren. Das Programm heif3t Pace.
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E Xilinx - ISE - L:\afb3\digitaltechnik
[ Fie [S4d View Project Source Process !

1 Ctri+X Category

Ciri+C Console

Ctri+y | = Floorplan Editor

Colors
Floorplan View
Overlays
s Package View
WA In Fles:., HTML Browser
§ Language Templates. .. | = IMPACT
Configuration Preferences
File Generation Controls () Constraints Editor

ISE General (®) Floorplan Editor —fj— 3

Editors .
Integrated Tools () Texteditor

Sources View

Text editor

Chi+F

Command line symta

exd Editor B

Constraints entry

m

Abb. 31 So wird — bei Bedarf — der richtige Editor ausgewabhlt. 1 - Edit-Dalog.
2 - Vorzugseinstellungen (Preferences). 3 - Auswahl des Floorplan-Editors.

# Xilinx PACE - L:\afb3\digitaltechnik\Xilinxversuche_11\uebung_01\uebung 01.ucf
Fle Edt View [0Bs Took Window Hep
DEFHE &« W LA BD LIRS » -

E_=] Design Browser

Abb. 32 Der getffnete Floorplan-Editor. 1 - hier sind die Pin-Nummern
einzutragen.

B Design Object List - /0 Pins [ X

. I/0 Name|l/O Direction| Loc |Function Block|{M
Output |

Input

Abb. 33 Die Pin-Nummern werden eingetippt. Einzelheiten in der folgenden
Abb. Nach der Eingabe ist die Datei zu schlief3en, wobei die neuen Inhalte zu
speichern sind.
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Abb. 34 Eine zweckmaRige Anschlu3belegung.

Wurden die AnschlufRbelegungen eingegeben, ist die Implementierung erneut zu starten. Nach deren
Durchlauf stehen die Programmierdaten bereit. Jetzt kann das Programmierprogramm aufgerufen werden.
Es heilt IMPACT. Versuchsplattform einschalten. Ggf. Verbindung zur Parallelschnittstelle des PC

herstellen.

Xilinx - ISE - Li\afb.
[& Fle Edit View Project

DAEG Lid B

Source! Synthe slsﬂmplemn
# uebung_01 |

= [ xci5144d-5TO100
= (€] uebung_01 (ueby

[ uebung_01 ucf (U

® Internet

Ve waan

& Programmzugriff und -standards
& ThinkVantage Productivity Center
R Windows Update

> Windows-Katalog

L] Meuses Office-Dokument

£? Office-Dokument dffnen

) Autostart

) Microsoft SQL Server 2005

@) Multimedia Center For Think Offerings
) Oriine Books

@ FC-Doctor S fur Windows

) SoundMax

= Remoteunterstizung
B, Windows Media Connect
B windows Movie Maker

D Hewlett-Packard

[0) +F Share-to-Web

= IR.LS. OCR-Regstrierung
0 Avira

@) Digtasimulatorys.57

@ irISE9.

/@ pecc s.02

@ PBWIN 9.02

) PowerBASIC Forms 2.0

() PENTAX Digital Camera Utiity 4
@ wrDpew

) LeardTech

) Atmel AVR Took

@) WhiteSmoke

@ Intro to Micros

() ABBYY FireReader 6.0 Sprint
) ArcSoft Connect

D) ArcSoft Scan-n-Stitch Debuxe

chnik\Xilinkversuche_1

Webun

01luebung_01_himifit\a)

VERRECHCECRE:

xco50"

[T Documentation

£ Profect Navigater

ﬂ Readme

[E seftware Dowrlosd Ceriter
&7 Uninstal i 1€

27

E HPower

B Architecture Wizard
o5 Constraints Editor
4] CORE Gererator
Floorplanner

G FrGA Edtor

Brc e
StateCAD

Timing Anayzer

@F Urinstal Last Update
@ webupdate

%, Xinfo System Checker

Abb. 35 Programmauswahl im Windows-Startmeni. 1 - der Programmierer
(IMPACT). 2 - der Floorplaneditor (PACE).
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‘ Fle Edt View Operations Opbions Output Debug Window Help
AHADEX #ENLD O 880 9N
=]
‘59 Boundary Scan
*8SmveSerial
SaSelecar
‘o9 Deskiop Configuration
‘o3 Direct SF1 Configuration

[5) SystemACE
[E) PROM File Formatiar

Iwant o

(®)[load most ecant project v [Browse.. |

[[] Load mostrecent project file when iMPACT starts

(O creste anew project {ipf) |default ip! || Browse

Operations |

Welcome to iMPACT
] Invoked WebUpdate Installer...

< >
sen| | Ouput | Emor | Waming

Abb. 36 Die IMPACT-Projekte haben mit den ISE-Projekten nichts zu tun.
Brauchen wir hier nicht. Fenster schliel3en.

> IMPACT

iMPACT - [Boundary Scan]
Drie car Yew SpeauE Otias OHPLL Debig VKoR TR
PR Y DEX XN 2830 2R
al——

‘23 Boundany Scan 1
22 SlaveSerisl
23 SelectMAP
3 Desktop Configuration
‘22 Direct SPI Configuration
[2) SystemACE
[£] PROM File Formatter

2

Right click to Add Dy

33—

Abb. 37 So wird die Programmierschnittstelle angesprochen. 1 - Boundary
Scan auswahlen. 2 - mit der rechten Maustaste draufklicken. 3 - Funktion
Initialize Chain ausfuhren.

E Progress Dialog [71%]

Connection to download cable...

Abb. 38 Der Programmierer versucht, die Verbindung herzustellen.
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£ iMPACT - [Boundary Scan]

% File Edit View Operations Output Debug Window Help

PH YDBX arxim 3 a0 o N2

Flows x
‘EolBoundary Scan
BalSlaveSerial
BalSelectMapP
‘BalDesktop Configuration
BoDirect SPI Configuration
[£) systemaCE
@ PROM File Formatter

£ Assign New Configuration File

Look in: | £ C:AVersuchsarchiv_11/ilinsversuche_1143 11d/° v 4 £ *'"

-1

2. 3v3_11d_html
D_ngo  Dast / 2
Il ) v3_ 11d jed

iMPACT Processes Fletype: |AlDesignFiles(jed isc™bsd) |

3
/ |
Modes File name: |v3_11d.jed |

(&) Mone
() Enable Programming of SPI Flash Device Attached to this FPGA
(O Enable Programming of BFI Flash Device Attached to this FPGA

Abb. 39 Wenn die Verbindung in Ordnung ist, erscheinen ein grines
Schaltkreissymbol sowie ein Dateidialog. Dann mul3 die Programmierdatei
gesucht werden. Die Dateiendung heif3t .jed (Jedec File). 1 - Verzeichnis des
Projekts suchen. 2 - Jedec-Datei auswahlen. 3 - weiter...

> iMPACT - [Boundary Scan]

% File Edit View Operations Output Debug Window Help

PEH YD OX X (1 a0 5N
X

® 28Boundary Scan Right click device to select operations
B3 SlaveSerial
SalSelectMaP
B9Desktop Configuration Le e
SalDirect SPI Configuration
SystemACE xc95144x]
@ PROM File Formatter v3_11djed
TDO

Abb. 40 Ist alles richtig ausgewahlt, wird das Schaltkreissymbol
aluminiumfarben. Jetzt weiter mit Dienst nach Vorschrift ...
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£ iIMPACT - [Boundary Scan]

!}Hﬁemmwumm Output Debug Window Help
PE XD EX/eXan {ti #BO BN
0 x

# GoBoundary Scan

“BalSlaveSerial 1
295 electMAP | /
‘aaDesktop Configuration L Program...
‘aalDirect SPI Configuration Verify
SystemACE weag  Erase...
[£)PROM File Formatter v3_11  Functional Test
00— —— Blank Check
Readback...
Get Device ID
Get Device Checksum
Get Device Signature/Usercode
Assign New Configuration File...

iMPACT Proc

Abb. 41 Mit der rechten Maustaste auf das Schaltkreissymbol klicken. Symbol
wird wieder gruin. 1 - dann auf Program klicken.

-3 Programming Properties

Category

IBER Programming Propeties
Advanced PROM Programming Propetties
Revision Properties

[¥] Verily P 2
General CPLD And PROM Propetties
Erase Before Programming [ Read Protect

PROM/CoolRunner| Usercode (8 Hex Digits) |

CPLD Specific Properties

| 3
| | ¥

[ ok | cancel |[ Appb | [ Heb J.:;

Abb. 42 Diese Eigenschaften der Programmierfunktion brauchen wir. 1 - vor
dem Programmieren I6schen. 2 - nach dem Programmieren Uberprifen, ob
auch alles stimmt. 3 - weiter ...

E Progress Dialog [46%]

Executing command...
TITTTTITITES J

Abb. 43 Die Programmierung lauft.
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£ iMPACT - [Boundary Scan]

% File Edt View Operations Output Debug Window Help

PH XDDOX &Xiim {3 2830 98

# S9Boundary Scan
aolSlaveSenal
aalSelectMaP

SaDesktop Configuration To!

SoDirect SPI Configuration
SystemACE
[£]PROM File Formatter

#3951 44x1
w3_fg jed

Available Operations are: A
=P Program

=pVerify

=pErase

=P Function Test

=P Blank Check

= Readback

b 3t Nasica 0 ~
Operations |

1% Boundary Scan

Abb. 44 Am Ende sollte es so aussehen. Nun kann die Schaltung ausprobiert
werden. Das IMPACT-Programm nicht schlie3en, sondern nur minimieren. Bei
den nachfolgenden Versuchen geniigt dann ein erneutes Anklicken.

TOI

xc95144x1
v3_fgjed

TDO

?}.— Question

\c)r) 'C:fversuchsarchiv_11/Xilinxversuche_11/v3_11hfv3_fg.jed'

This file has been modified outside of IMPACT, Do you want to reload it?

1 ves || N |

7

Abb. 45 Wird IMPACT wieder aktiv, so erscheint diese Anfrage. Sie mul3 mit
Yes bestatigt werden, da die Programmierdatei vom Entwicklungssystem neu
erzeugt wurde. Dann wird erneut programmiert. Erscheint die Anfrage nicht, ist
etwas falsch gelaufen...

Aufgabe 2: Passende Taktfrequenzen herstellen

Das Toggle-Flipflop wird nicht immer richtig funktionieren. Das liegt daran, daB die Taste prellt. Man
kann Tasten entprellen, indem man sie mit einem Takt von einigen 10 bis wenigen hundert Hz
synchronisiert. Auch brauchen wir einen langsamen Takt, um beispielsweise ein Lauflicht vorfiihren zu
kénnen. Die Versuchsplattform hat aber nur einen Grundtakt von 16 MHz. Niedrigere Taktfrequenzen
sollen erzeugt werden, indem wir diesen Takt im Verhéltnis 1:2%* = 16 777 216 teilen. Hierzu bauen wir
einen 24-Bit-Zahler auf. Passende Zahler finden wir in der Kategorie Counter.
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Abb. 46 Erst einmal die Funktionselemente bereitlegen. Die bisherige Schaltung wird geldscht.
1 - 16-Bit-Zahler. 2 - 8-Bit-Zahler. 3 - wir entprellen gleich alle vier Tasten der Versuchsplattform
(sozusagen auf Vorrat). In der Kategorie Flip-Flop finden wir ein Register mit vier D-Flipflops. 4 -
erganzend dazu aus der Kategorie Logic Negatoren im Viererpack (inv4).

Hinweis: Wer schneller zum Erfolgserlebnis kommen will, kann die Tasten und das Entprell-Register
zundchst weglassen. Diese Teilschaltung brauchen wir erst fiir die Aufgabe 4.
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Rename Bus

(®) Rename the Branch's Bus
() Fename the Branch

Cument Base Name of Bus
[ e

MNew Baze of Bus.
c1l

Fielated Buses and Nets

Highlight

X

A

Claar Al

Ceriter

B~

Zoom Out

Abb. 47 Die (fast) fertige Schaltung. a) die Ausgangssignale der
hochstwertigen acht Zahlerstellen sollen auf die LEDs gefuhrt werden. Auch die
Puffer gibt es in Vierfach- und Achtfachausfiihrung. Einige Signale miissen noch
benannt werden. 1 - etwas Neues; ein Bus. b) so erhalt der Bus seinen Namen.
Auf den Bus klicken (wird rot). Rechte Maustaste. Dann auf Rename Selected
Bus klicken. 2 - Namen eingeben. 3, 4 - in dieser Folge anklicken.

; Object Properties

Category
(& Nets
cTE0)
Name Value Visible [ New I | ‘
MName CT:m) Add — .
PotPoleity  Notapon [ Aca ) LEdtTreits | o} | [Cree ]|
Delete |} Atribute Display Location }
- | Sheetl, Zone 3-B, [1168. Delete i
1 o 2 Delete all | |
4 ) il |
] ————————
| NetLacation _
] | <blankitem> v| AddAl

R TN R T 4 e

Abb. 48 Der Name ist aber noch nicht zu sehen. Wie machen wir ihn sichtbar?
Den Bus nochmals anklicken. Rechte Maustaste. Dann auf Object Properties
klicken. Dann in der Reihenfolge 1 — 2 — 3 — 4 klicken.
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Rename Net

(®) Rename the Branch's Net
() Rename the Branch

o @

Display the Net Name on the Clicked Paint(lf
Itls Mot displayed on the Branch)

[ OK ]l Cancel ” Help ]

Abb. 49 Jetzt kann der Takteingang der Entprellflipflops benannt werden. Wir
schlieRen ihn an den dritten Ausgang des Zahlers an. 1 - Leitung anklicken.
Rechte Maustaste, dann Rename Selected Net. 2 - Namen eintragen. 3 - dieses
Hakchen setzen, damit der Name im Schaltbild erscheint. 4 - die Ausgange
werden ebenso benannt wie der Bus (anklicken, dann Rename Port).

Abb. 50 Die fertige Schaltung. Auch die entprellten Tastensignale haben
Namen erhalten.

Jetzt die Constraints-Datei aufrufen und alle Pinnummern léschen. Die Datei wieder schlieRen
(speichern). Nun alles implementieren.
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B Design Object List - I/0 Pins D@@

. 1/O Name|l/O Direction| Loc |Function Block|M

o

[ LED<5>
B LED<4>
B LED<3>
I LED<2>
[ LED<1>
B LED<D>

K Input

| = A R D S ST T I

Abb. 51 Jetzt wird die Constraints-Datei wieder aufgerufen, um die neuen
Pinnummern einzugeben.

Constraints-Datei schlielen, nocmlasi implementieren und dann programmieren. An den LEDs muR das
typische Zéhlverhalten zu beobachten sein

Aufgabe 3: Lauflicht
Die Schaltung wird umein Schieberegister erganzt, dessen Ausgénge an die LEDs angeschlossen werden.
Um die Benennungen zu erhalten, wird zunéchst der Output Buffer gel6scht.

- CB8RE
-aprgp == S170) 8 V=00
—{CcE CEO |—a
—e Tl —a
ETE TR
SESERREEE) EEFEEEE

Durch Léschen des Output Buffers wurde der Signalweg getrennt, so da nunmehr das Schieberegister
eingebaut werden kann. Wir verschalten es als selbsteinschwingenden Ringzahler. In der Kategorie
Shift_Register finden wir passende Typen, in der Kategorie Logic das NOR-Gatter mit sieben Eingangen.

Abb. 52 Die Grundschaltung. Das Schieberegister hat einen Busausgang. Er
ist hier schon benannt und tber einen Output Buffer mit den LED-Ausgangen
verbunden worden.
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Add Bus Tap Options

‘When you add a bus tap, setits
arientation so that the broad end —the
part that connects to the bus —is at the

2 Top
O

Left>= ®) () —<Right
@)

Bottom

Abb. 53 Jetzt wird der Bus mit dem NOR-Gatter verbunden. Die einzelnen Leitungen werden
Uber Anzapfungen, sog. Bus Taps, angeschlossen. 1 - Funktionsauswahl zum Hinzufligen von
Bus Taps. 2 - hier wird die Orientierung der Anzapfung gewabhlt. Mitdenken! 3 - so wird ein Bus
Tap angefligt. Es dockt automatisch an den Bus an. 4 - der Takteinang wurde bereits benannt
und auf diese Weise mit einem hinreichend niederfrequenten Takt verbunden.

SRR Ll ==

E Rename Net

-:| (® Fename the Branch's Net

- () Rename the Branch

A [sray

: Display the Met Name on the Clicked Point(if
Itls Mot displayed on the Branch)

| 0K |[ Cancel H Help

Abb. 54 Nun mussen die Bus Taps einzeln benannt werden — eine mihevolle
Arbeit; es hilft alles nichts...
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Abb. 55 Die fertige Schaltung. An der Constraints-Datei ist nichts zu andern.
Implementieren, programmieren und zusehen, ob es funktioniert.

Aufgabe 4: Zwei Binérzéhler mit Handbetétigung und Anzeige

Als Endziel wollen wir einen Impulsmustergenerator als Prifgenerator flr serielle
Schnittstellen bauen. Hierbei ist ein Prifzeichen von acht Bits L&nge einzugeben. Wir haben
aber keine acht Kippschalter. Deshalb ordnen wir zwei Einstellzahler zu vier Bits an, deren
Ausgénge auf die LEDs gefuhrt und deren Takteingénge von zwei Tasten angesteuert werden.
Der bishierige Schieberegisterentwurf wird hierzu geléscht. Die LED-Ausgange bleiben.

L CB16RE
vee

Abb. 56 Die fertige Schaltung. Ausprobieren...

Jetzt sollen — um den Bedienkomfort zu verbessern — zwei Siebensegmentanzeigen
angeschlossen werden. Die Siebensegmentdecoder sind als Funktionselemente schon
vorgefertigt. Sie sind als Kopien externer Quellen dem Projekt hinzuzufugen.
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Add Copies of Existing Sources

Suchenin: | hex_segments x| «sBoE
b Name Grofe. Typ Geandert
Zuletzt :ﬁ_rex_segmm.resw'e 42KB RESTORE-Datel 21.05.201
verwendats Dok, | Sihex_segments.jhd 1K HD-Datel 20.05.201
© | Ehex_segments.ise_ISE_Backup 169 KB [SE_JSE_BACKLP-Datsi  21.05.201
B Jrvesc_segments e 169KE Yiiro: ISE Project 21.05.201
2KE SYM-Datel 20,05.201
Destop 25KB SCH-Datel 20.05.201
Dateiordner 20,05.201
Eigena Dateien
Arbeitsplatz
Netzwerkumgebu ¢ ¥
ng
Deteiname: ["HEX_7SEG sym" "HEX_7SEG sch® ~| finen
Dateityp: [aufies =9 -] Abbrechan

Abb. 57 Quellenauswahl tiber Project — Add Copy of Source. Wir brauchen den
Schaltplan (.sch) und das Schaltsymbol (.sym). Also Datentyp auf All files.
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Hinweis: Beide Dateien missen den gleichen Namen haben, sonst funktioniert es spater nicht
(hier: HEX_7SEG.sch (Schaltplan) und HEX_7SEG.sym (Schaltsymbol).

[ Xilinx - ISE - L:\afb3\digitaltechnik’
[@ Fle Edit View Project Source Process J

DPHA L iDEX ne

QOR A

| A

Source! Synthesis/implementa v |

T Fueb2x

= [ xc951444-5TC100

B hex_segments (hex_sec

= [O]dhueb2x (ueb2x sch)
[ ueb2x uct (ueb2x uch)

Abb. 58 Der hinzugefugte Schaltplan sollte jetzt im Verzeichnis der Quellen

auftreten.

QOR AL

: Xilinx - ISE - L:\afb3\digitaltechnik\Xilinxversuche_11\ueb2x\uebix. ise - [ueb2x sch*]
B Fle Edt View Project Source Process Add Took Window Hep

DS b ALEX wa Q- FEEXAE R A 2800 AW ik YEIVEM@E O @Ak VP -2 N0/

Categories

[¢=All Symbiols=> =
L-/fo3/digitaltechaillin:
Agittmetic

Bufler

Comparaior

Courter

Decoder

Flip_Flop

|General

0

|Latch

Ei
Symbole

Symbol Name Fier

Orientation
Fiotate 0 ~

gl

I CHAeR

i [T LEME T

s G Ty

Abb. 59 Die Funktionselemente werden in die Schaltung eingebaut. 1 - Symbolauswahl. 2 -

ein bereits eingefligtes Schaltsymbol. 3 - Schaltsymbol wahrend des Einfiigens.
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Abb. 60 Die fertige Siebensegmenterweiterung. R = rechte, L = linke Anzeige.
Die Ausgabepuffer sind bereits in die Decoder eingebaut. Constraintsdatei
gemal AnschluRtabelle ergénzen. Ausprobieren...

Das Praktikum schliefit mit zwei wahlweisen Aufgaben. Wir bauen entweder eine Stoppuhr (Aufgabe 5)
oder einen Prifgenerator fiir serielle Schnittstellen (Aufgabe 6). Beides nur provisorisch unter Verzicht
auf letzte Feinheiten. Naheres im Wahlfach Entwurf digitaler Schaltungen (EDS).

Aufgabe 5: Stoppuhr

Die Stoppuhr soll im Raster von 0,1 s bis 9,9 s zahlen. Betatigung: Taste 0: Zahlen/Stop (Toggle-
Funktion); Taste 3: loschen. Wir wechseln zunachst die Binarzéhler gegen Dezimalzahler aus
(Binarzahler 16schen und Dezimalzahler CD4CE einfligen). Dann schalten wir beide zu einem
zweistelligen Zahler zusammen. Das Zéhlen wird von einem Toggle-Flipflop Uber den
Zahlerlaubniseingang der niederwertigen Zahlstelle gesteuert. Als Z&hltakt wahlen wir CT(3) oder CT(4).
CT(3) ist das Ausgangssignalk eines insgesamt 20steilligen Binarzéhlers (16 + 4 Stellen), CT(4) das
Ausgangssignakl eines 21stelligen. Mit CT(3) werden die 16 MHz durch 2% geteilt (15,26 Hz), mit CT(4)
durch 2% (7,63 Hz). Das ergibt eine Taktperiode der Stoppuhr von 65 oder 130 ms.

Die Grundschaltung ist schnell aufgebaut, hat aber zwei auffallende Méngel:

1. Sie zahlt nicht genau im Rhythmus einer Zehntelsekunde, wiirde also zur Zeitmessung nicht
zugelassen werden.

2. Sie halt nicht bei 9,9 s an.

Um den ersten Mangel zu beseitigen, missen wir die 16 MHz exakt durch 1 600 000 teilen. Hierfur ist
die Zéhlerstellung 1 599 999 zu decodieren und damit der Zahler zurlickzusetzen.

1599999 =1 1000 0110 1001 1111 1111B.
Wir brauchen also ein UND-Gatter mit 21 Eingangen. Dessen Ausgang wird mit den Riicksetzeingangen

der beiden Frequenzzahler verbunden. Das Ausgangssignal liefert zugleich die Zahlerlaubnis fur die
Dezimalzéhler.
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Um den zweiten Mangel zu beseitigen, ist die Endstellung der Dezimalz&hlung (99 = 1001 1001B) zu
decodieren und damit das Weiterzahlen tiber den Z&hlerlaubniseingang verhindern. Die Decodierung ist
aber schon in die Zahler eingebaut (Ausgénge TC). Lassen Sie sich was einfallen...

Abb. 61 Die Grundschaltung der Stoppuhr. 1 - der Zahltakt. Ausprobieren...

Abb. 62 Die Zahlschaltungen sind umzubauen. 1 - die Zahler der Stoppuhr
werden an den 16-MHz-Takt angeschlossen. 2 - die Zahler der Frequenzteilung
werden an den neuen Decoder angeschlossen. 3 - die Z&hlerlaubnis kommtvon
einer neuen Schaltung. 4, 5 - diese Signale werden benétigt, um das
Zahlerlaubnissignal 3 zu bilden.
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Es ist zweckméRig, die zusatzlichen Gatterschaltungen auf einem neuen Blatt zu zeichnen (wie man dazu
kommt, steht weiter hinten).

Den Bus des 16-Bit-Zahlers nennen wir CX(15:0). Es sind sieben Nullen und 14 Einsen zu decodieren.
Damit wir nicht so viel zu zeichnen haben, bauen wir das grof’e UND-Gatter aus Gattern mit negierten
und mit nichtnegierten Eingangen auf. Wir brauchen sieben negierende und 14 nichtnegierende Eingénge.

Die zu decodierende Binarzahl:

CT(...) CX(..)

4 3 2 1 0 15 (14 |13 (12 |11 |10 |9 8 7 6 5 4 3 2 1 0

1 {10 )0 |0 |O |2 (2 |O |2 JO |O (2 (2 |2 |2 |1 |1 (1 (1 (1

Zahlerlaubnis: Die Stoppuhr soll zahlen,

» wenn der Frequenzteiler durch Null geht (also der Decoder aktiv wird) UND

» wenn das Toggle-Flipflop aktiv ist UND

« wenn die Endstellung (99) NICHT erreicht ist, wenn also TC1 und TC2 nicht beide zugleich Eins
sind (NAND-Verknipfung).

CK{‘I?J : see [EEEEEEEES AN fes . ser e ‘e

- ommeser

il COUNT_ENABLE:

k@

Abb. 63 Die zuséatzlichen Schaltungen. 1 - Decoder. 2 - Zahlerlaubnis. 3 - so
kommen wir zu den UND-Gattern mit negierten Eingangen. Diese
Funktionselemente haben ein B in der Bezeichnung. AND3B1 heil3t: drei
Eingadnge,davon einer negiert. Ein Gatter AND4B4 hat demzufolge vier
Eingange, die alle negiert sind.
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Aufgabe 6: Prifgenerator fir serielle Schnittstellen
Erprobung: (1) mit Oszilloskop, (2) mit Windows-PC und Hyperterminal.

Der Priifgenerator soll ein einzelnes Prifzeichen senden. Das gesamte Prifmuster ist 16 Bits lang:

1. 2. 3. 4. 5. 6. 7. 8. 9. 10. 11. 12. 13. 14. 15. 16.

Start Priifzeichen (ASCII) Stopbit + Ruhezustand

0 Bit Bit Bit Bit Bit Bit Bit Bit 1 1 1 1 1 1 1
0 1 2 3 4 5 6 7

Das Priifzeichen (ASCII):

Einstellzéhler 2 (KEY1) Einstellzéhler 1 (KEYO)

Bit 7 Bit 6 Bit5 Bit 4 Bit 3 Bit 2 Bit 1 Bit0

Der ASCII-Code:

012 3 4567 8 9 ABCDEF
20: * VRS & (D>, —
3: /8123456789 :;<=>7
4W0:/@ABCDPDEFGHIJKLMNDO
S/PQRSTUUNERERY ZILNIT® _
60:|* abcde fghijgklmno
70:pqrstuuwxyz{l}‘“[_

Beispiel: Prifzeichen "1" = 31H, Prlfzeichen "A" = 41H.

Abb. 64 Die Hilfsschaltungen. Taktteiler, Entprellung, Einstellzahler, Anzeige.
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Abb. 65 Die Grundschaltung: Ein Multiplexer wird mit dem zu sendenden
Bitmuster belegt und zyklisch abgefragt. Darstellung auf einem neuen Blatt des
Schaltplans (wie man dazu kommt, wird weiter unten erklart).

Abb. 66 Der Frequenzteiler fir den Bittakt (Baudrate). Wir wollen mit 2400
Bits/s senden. Dazu sind die 16 MHz durch 667 zu teilen.
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Neue Ausgdnge (zum Eintragen in die Constraints-Datei):

TX: Pin 94 (TXD der seriellen Schnittstelle).

SYNC: Pin 85 (Pin 2 des 40poligen Steckverbinders).

Schritt 1: Grundschaltung wie beschrieben implementieren (zyklischer Umlauf) und zunédchst mit dem
mit Oszilloskop, dann mit dem Hyperterminal erproben. Ggf. probeweise den heruntergeteilten
Abfragetakt auf SYNC legen und nachsehen, ob es stimmt.

Schritt 2: Die Anordnung soll nur senden, solange die Taste 2 niedergehalten wird (ansonsten schreibt
es den Bildschirm zu schnell voll). Es ist eine vollsynchrone Ldsung zu finden, so dall nur ganze
Prifmuster gesendet werden und im Ruhezustand TX auf Eins gehalten wird (ansonsten synchronisiert
das Hyperterminal nicht richtig und zeigt Mist an). Lassen Sie sich also was einfallen ... Praxistip: Den
Datengenerator immer umlaufen lassen und nur das Senden freigeben oder sperren. Taste 2 nach jedem
Umlauf abtasten.

Schritt 3: Erweiterung auf das Senden einzelner Zeichen. Betatigung von Taste 3 soll bewirken, dal nur
ein einziges Zeichen gesendet wird (Single-Shot-Betrieb).

Wie kommen wir zu weiteren Blattern im Schaltplan?
1. Mauscursor irgendwo auf die freie Zeichenflache.
2. Rechte Maustaste. Dann Object Properties.

3. Dann New - OK - OK.

Sheets
Bus Renaming
Name Size | MoveUp
1 C=22x17in
2 C-22x17in
3 C=22x17in Py—
Undelete
1 E New Sheet
Mew ...
Sheet Numbers 2
14 _
| Al l' Sheet Size ]
C=22x17in
3ok J[comcel J [ apety J[ _rew | : [ e ]
- f'..'f1::::1:::'..':::'..':::'..':'::

Abb. 67 Anfordern eines neuen Blattes. 1 — 2 — 3: in dieser Reihenfolge
klicken. Ggf. zuvor Papierformat auswahlen (Sheet Size).

Praxistip: Wenn der Schaltplan gedruckt werden soll (Projekt, Abschluarbeit usw.), auf Format A4
gehen und die Schaltung auf entsprechend viele Blatter aufteilen. Macht zwar etwas Arbeit, sieht aber
VIEL besser aus...
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Anschlufl Pin
Taste 0 49
Taste 1 46
Taste 2 43
Taste 3 42
LED O 41
LED 1 40
LED 2 39
LED 3 37
LED 4 36
LED 5 35
LED 6 97
LED 7 96
Quarztakt 22
Segment A links 72
Segment B links 71
Segment C links 70
Segment D links 68
Segment E links 67
Segment F links 66
Segment G links 65
Taste oder Dezimalpunkt links 64
Segment A rechts 85
Segment B rechts 82
Segment C rechts 81
Segment D rechts 80
Segment E rechts 79
Segment F rechts 78
Segment G rechts 77
Taste oder Dezimalpunkt rechts 76
Serielle Schnittstelle, Sendedaten (TXD) 94
Serielle Schnittstelle, Empfangsdaten (RXD) 92




36

Versuch 3

Praktikum Digitaltechnik SS 2011

Die hexadezimale Siebensegmentanzeige:
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Die Innenschaltung des Siebensegmentdecoders:

D4_16E

Al

AD

Al

Do
D1

D2

D(15:0)

8/
S

[SEG_An>

Y

{ SEG_Bn)

&

{sEG_cn>

{SEG_Dn>

5/

8

{SEG_En»
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{ SEG_Fn)

5/

{SEG_Gn>»
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